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Pride
I began my second year as president of Washington Apple Pi 

with a great deal of pride. Over the summer, the Pi Board of Di-

rectors worked with George Mason University to iron out the 

final details for the Washington Apple Pi Scholarship at George 

Mason University. On 1 September 2016 George Mason Uni-

versity issued a press release announcing the scholarship. The 

press release can be viewed at:

https://volgenau.gmu.edu/news/255181

As a community of Apple iPad, iPhone and Mac users, people 

with a common aim to improve knowledge and enjoyment of 

Macintosh computers and Apple mobile devices, the Pi’s philos-

ophy has always been one of “users helping users.” We should 

all be proud that we are now extending this philosophy forward 

for years to come by devoting some of our financial resources 

to help students at George Mason University. Thank you all for 

your support in creating this scholarship, and a special thanks to 

Larry Kerschberg and his late wife Nicole for conceiving the idea 

and proposing the scholarship.

President’s Page

Pride…and A Couple of Pleas for Help 
Ken Goldman

If anyone would like to make a personal contribution to the 

Scholarship’s endowment, here are two ways you can do it:

Online: give.gmu.edu

Write in the “other” section: Washington Apple Pi Scholarship 

Fund, fill out the form and pay by credit card. 

Mail a check: GMU Foundation, 4400 University Drive, MS 1A3 

Fairfax, Virginia 22030. 

Checks should be made out to: GMU Foundation and the des-

ignation, Washington Apple Pi Scholarship Fund.

A Couple of Pleas for Help
Over the years, the Pi has undergone a lot of changes, perhaps 

the most significant of which has been the decreasing member-

ship. In September 2015, The New York Times published an ar-

ticle titled “Mac User Groups Fade in Number and Influence, but 

Devotees Press On.” 

http://www.nytimes.com/2015/09/09/technology/personaltech/apple-mac-

user-groups-devotees-press-on.html?_r=0

Reading this article was somewhat encouraging to me, as the Pi 

is larger and more vital than most of the other groups around 
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the country and the world. If you look back on the 

past year we have had some exceptional events, 

such as our joint meeting with Asbury Methodist Vil-

lage featuring Walt Mossberg, Jimmy (“JimmyMac”) 

Obomsawin’s talk about home automation and 

HomeKit, the Pi Photo Contest, and presentations on 

what’s new at Apple from Aaron Davis.

I think that we can all agree that this is an exciting 

time for Apple products, but the world has changed. 

Many users now view their Macs, iPhones and iPads 

as appliances. With the advent of Internet resources 

like YouTube and the Genius Bar at Apple stores, the 

appeal of and perceived need for User Groups have 

faded…but, I believe that they are more unknown 

than irrelevant. We frequently have non-members 

show up at a Clubhouse Saturday seeking help. Our 

members collaborate to solve their problem, making 

them believers, and frequently new members.

This leads to plea number one: I would like to ask 

all of you to jump on the bandwagon to help inform 

the world that we are still here and they should 

check us out. We have a new tri-fold pamphlet and 

a flyer with www.wap.org tear-outs at the bottom. 

I encourage all of you to pick up a few brochures at 

the monthly meetings, and hand them out and post 

them. 

Now to plea number two: As you all know, the Pi 

is an all-volunteer organization, which currently de-

pends on a small group of people to get all the work 

done. Because of this, the bench is very thin (typi-

cally one person) for each function. As we all have 

lives, this means that some things do fall through 

the cracks. I would like to ask each of you to think 

of how you can help support the Pi and jump in to 

help; if you feel we are falling short in some way, 

please help us to succeed in that area. Some things 

you can do include, but are not limited to:

Write an article for The Journal. You don’t need to be 

a tech expert; an amateur just relaying their experi-

ences can often write an article that is interesting 

and helpful to others.

Volunteer to edit The Journal. Jay Castillo has been 

doing this job for about five years now and is ready 

to hand the reins to someone new.

Help to find speakers for our General Meetings and 

Afternoon Learners SIG meetings. We currently have 

one person, Jonathan Bernstein, working on this, 

with input from the Board. It is a heavy load for just 

one person. I would like to develop a Program Com-

mittee with at least two other volunteers to work 

with Jonathan. If you are willing to help, please vol-

unteer. Also, if you have any ideas for speakers or 

subjects, please share them, and then work with the 

committee to make them happen.

Help with some of the day-to-day admin details 

of the club. There are lots of things we do behind 

the scenes, most of which are handled by the same 

small group of volunteers. If you can just take up 

one job from someone else it would help tremen-

dously. Please send me your name and we will pro-

vide you with some options.

Thank you all for being Pi members. I look forward 

to seeing all of you at upcoming meetings. As we 

head into the holiday season, I wish you all Happy 

Holidays and a Happy and Healthy New Year.


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Editor’s Page
Jay Castillo

Hello, it’s been a while since I was here. As you are well aware, 

the Journal issues have become intermittent. When I became 

the Journal managing editor in 2011, we were publishing six 

issues per year. Now we are struggling to publish two issues per year. In 

previous issues I have urged members to contribute articles for publication 

on any subject pertaining to Apple products or digital life in general. A few 

stalwart folks have responded, but too few, and too slowly. In January 2010, 

we had 803 Pi members; today we have 358 members, so, the pool of po-

tential contributors has decreased significantly.

I am very proud of the quality journals we have published over the years, 

relying on the membership for content.  But we now face the daunting 

question of how we continue the publication of the Pi Journal. Is it to be-

come an annual publication? Does it remain simply sporadic? Do we go 

to some other type of publication? Please let me or any member of the Pi 

Board of Directors hear from you, the members. We welcome ideas for the 

future of the Journal. Meanwhile, enjoy this one.
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When Bad Things Happen to Good Macs
Jay Castillo

The Problem
I was enjoying my daily perusal of Internet sites, using Safari, 

when a pop-up message appeared. Unfortunately, I didn’t cap-

ture an image of it, but it said something like, 

You have a problem with your system. If you quit your 

browser or shut down your system, you will damage your 

hard drive or lose data. Click here to get help. 

The only available button in the pop-up window was “O.K.” The 

pop-up window appeared to be consistent with OSX formats, 

but I was immediately highly suspicious. So I hit “Command-

W” to close the window: Nada! Then I did the same for Safari: 

Bupkes! I then did the Force Quit routine for Safari: No re-

sponse! Safari was locked tight, and I was stuck. 

Next, I restarted the system. It booted up again, but when Safari 

started up, there was the pesky pop-up window, just as before 

I rebooted. Unfortunately, I had set Safari preferences to “open 

with all windows from last session”, (see Figure 1) and that’s 

what I got. I gritted my teeth, disconnected from the Internet, 

hoping nothing nefarious could be downloaded if it wasn’t 

there already, and clicked ”O.K.” Up came a second pop-up, with 

a phone number to call and with an advertisement for repair 

of my Mac, but nothing to click. I was then able to close all win-

dows. What had happened to my iMac, and what could I now 

do to ensure my system wasn’t corrupted and to keep it from 

happening again?

I was the victim of malware. Wikipedia defines malware as, 

Malware, short for malicious software, is any software 

used to disrupt computer operations, gather sensitive 

information, gain access to private computer systems, or 

display unwanted advertising. Malware is defined by its 

malicious intent, acting against the requirements of the 

What had 
happened to my 
iMac, and what 
could I now do to 
ensure my system 
wasn’t corrupted 
and to keep it 
from happening 
again?

Figure 1: Safari Preferences-Safari 
Opens With…
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computer user, and does not include software 

that causes unintentional harm due to some 

deficiency. 

Malware is a persistent threat to any computer 

user, and Macs are being subjected to it more and 

more. Security through obscurity is no longer true, if 

it ever was. 

The Solution
Fortunately for me, a few days earlier at the Pi 

Clubhouse Saturday session, one of my sainted col-

leagues had shown me a free-for-Macs anti-malware 

application, called, Malwarebytes. I went to the com-

pany website:  

(https://www.Malwarebytes.org/antimalware/mac/) and 

downloaded the application. Figure 2 shows the 

application window when opened. The interface 

is simple, and clicking on “Scan” starts the process. 

The scan of the system was quickly done and found 

several pieces of malware, which were removed (see 

Figure 3). Clicking on “Scan” again provided the all-

clear message shown in Figure 4. Note that there are 

additional steps you can take if the problem persists: 

You can click on “What to do if your problem was 

not solved,” or click on “ Next Steps” in the applica-

tion main window. I recommend going to “Next 

Steps” to learn about what can be done to combat 

malware and prevent being victimized. There is 

a specific page for scam pop-ups and what to do 

about them  

(http://www.thesafemac.com/tech-support-scam-pop-ups/).  

I also changed my Safari Preferences to Safari 

“Opens with a new window” from the drop down 

menu shown in Figure 1.

I noticed that the scam pop-up page provided by 

the above link declared, 

It is also important to understand that these 

messages are not caused by a virus, or any 

Figure 2: Malwarebytes main window Figure 3: Malwarebytes scan results Figure 4: Malwarebytes Scan declares “All Clear”
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other kind of malware. Many people’s first 

reaction to a pop-up like this is to go down-

load anti-virus software. This is the wrong 

response, as there is no malware involved, 

and thus the anti-virus software will not solve 

the problem. 

I suppose that Malwarebytes does not define JavaS-

cript pop-ups, as these are, to be malware. They 

seem to distinguish them as “adware.” 

As I was responding to the changes to the draft of 

this article, made by one of our esteemed editors, 

another pop-up appeared in Safari. This time I 

was able to grab a screenshot, shown in Figure 5. 

Fortunately, force-quitting Safari got rid of it, since I 

couldn’t close any browser windows. Figure 6 shows 

another example that I encountered. Note that one 

message appears to be from a Mac support website, 

while the other appears to be related to my Internet 

provider. To the uninitiated, these messages might 

appear worrisome and require the directed actions. 

However, the Malwarebytes support pages declare:

 It is important to understand that no website 

can scan your computer for malware or 

suspicious activity. Further, Mac OS X will 

never display such a message within your web 

browser. (If you are unsure as to whether the 

alert is being shown by your browser or by 

the system, try hiding the browser by pressing 

command-H. If the message hides as well, it’s 

being displayed by the current page.) At most, 

web browsers can warn you that a particular 

site you are trying to visit is bad, but they 

cannot make any determinations as to the 

state of your computer.

This experience prompted me to rethink my 

approach to anti-virus software. I have been using 

the free application, Virus Barrier Express, which 

has consistently declared my iMac to be virus-free. 

My sainted colleague had also recommended 

Bitdefender Anti-Virus for Mac. I went to the website 

(http://www.bitdefender.com/solutions/antivirus-for-mac.

html) and downloaded the free 30-day trial version. 

Figure 7 shows the application window. The 

interface is simple and understandable. When I ran 

Figure 5: I encountered another pop-up window.

Figure 6: Yet another example of nefarious pop-ups.

Figure 7: Bitdefender App main window	
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

Bitdefender, I got the result shown in Figure 8. I clicked on “Delete manually,” 

ran it again, and the result is shown in Figure 9. So this app found a virus that 

my previously used app did not. Scary! A useful feature of Bitdefender is that it 

automatically updates itself in the background, and provides a notification when 

it does so.

My trial period for Bitdefender has now expired, and I have to decide if I want to 

cough-up $39.95 for a one-year subscription. A subscription for up to 3 Macs 

is $59.95. The subscription can be for two or three years with a corresponding 

increase in price. I think I’ll shop around; there are some decent free apps, 

such as Avira. But I now have a better and more serious appreciation of the 

threats to which the Internet exposes us, and I think I need to be more careful 

and certainly more proactive. And I highly recommend attendance at the 

Pi Clubhouse Saturdays.

Figure 8: Bitdefender scan results

Figure 9: Bitdefender declares, “Your Mac is Safe.”

mailto:feedback%40wap.org?subject=
mailto:feedback@wap.org


Washington Apple Pi Journal
Volume 38, No. 1

11

What’s New From Apple
Brent Malcolm

Apple has recently released the newest versions of 

their operating systems. They are now available for 

download, and here is an overview of what to ex-

pect from them. 

MacOS and iOS
MacOS Sierra adds support for Siri, enhances Photos with 

automatic recognition technologies, and enables Apple Pay for 

the Web so you can use Apple Pay for things ordered online 

with Safari. To integrate the Mac more deeply into Apple’s 

ecosystem, you’ll be able to auto-unlock your Mac when you’re 

wearing an Apple Watch, copy and paste between your Mac 

and your iOS devices, and access everything in your Desktop 

and Documents folders on any iOS device via iCloud Drive. 

Minor changes add tab support to all apps and add picture-in-

picture support in case you ever wanted to watch a video while 

you’re doing other tasks. 

The changes to iOS are even more far-reaching. The lock screen 

is enhanced to allow sideswiping to reveal access to widgets 

and the camera. 3-D touch allows notifications to display ap-

plication data without unlocking. For instance, you can press an 

iMessage notification to see the conversation. Siri will be opened 

to developers, which should result in sweeping enhancements 

of current and future third-party iOS apps. For example, you’ll 

be able to use Siri to call a car with Uber or Lyft. Typing sugges-

tions will be improved, Photos will be enhanced, and Maps will 

gain more capabilities. Lastly, the Music app is redesigned and 

HomeKit is improved. 

watchOS and tvOS
The biggest watchOS improvement is faster apps launching. 

Additionally, there are more watch faces and simplified mes-

sage reply. The side button now displays the Dock, which you 

can configure with your most-used apps, and swiping up from 

the bottom of the screen shows Control Center. Pressing and 

holding on the side button brings up an SOS screen for mak-

ing an emergency call. Apple has improved the popular Timer 

app, and the Activity app now offers activity sharing and gains 

awareness of the activity of wheelchair users. A new app called 

Breathe helps users relax with deep-breathing exercises.

Finally, tvOS 10 enhances its support for Siri; for instance, you 

can use Siri to find a particular YouTube video or a particular 

sporting event. Instead of requiring a sign-on for every cable 

or satellite connection, Single Sign-on simplifies login to apps 

mailto:feedback%40wap.org?subject=
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that require cable or satellite subscriptions. A new “dark mode” 

is added for those who find the brightness of the interface visu-

ally painful. A new iOS Remote app will do everything the Siri 

Remote can, including work with Siri, navigate the interface, and 

act as a game controller. Finally, if you get an iOS app with an 

Apple TV version, it will download automatically, saving you a 

search in the Apple TV App Store.

Am I Compatible?

It’s all well and good to swoon over the new software, but will 

my Mac/iPhone/iPad run the new offerings? Here’s the list of 

compatible hardware for macOS Sierra: MacBook (Late 2009 and 

later); iMac (Late 2009 and later); MacBook Air (2010 and later); 

MacBook Pro (2010 and later); Mac mini (2010 and later); Mac 

Pro (2010 and later); iPhone 6s; iPhone 6sPlus; iPhone 6; iPhone 

SE; iPhone 5s; iPhone 5c; iPhone 5; iPad Pro 12.9 inch; iPad Pro 

9.7 inch; iPad Air2; iPad Air; iPad 4th generation; iPad Mini4; iPad 

Mini3; iPod Touch 6th generation. Please note that this is a pre-

liminary list and it may change. 

So, download these software updates and look forward to en-

joying all these improved user capabilities. And, in Apple’s usual 

grand design, they’re all free! 

mailto:feedback%40wap.org?subject=
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Customizing the Finder Window
Neil McNamara

One of the truly great things about a Mac 

is that you can customize it extensively to 

look and feel just the way you want it to. 

There are several ways to do this, beginning by ad-

justing preference settings. Your Mac has two types 

of preferences: System Preferences and application 

preferences. When you get your Mac, Apple has set 

all of these preferences to certain default values, but 

you will almost certainly want to make changes from 

those factory settings.

System Preferences are settings that affect how 

some aspect of your Mac works, no matter which 

application(s) you are currently running (Figure 1). 

They allow you to control things like the way your 

mouse or trackpad work, or change the Desktop 

Background picture, or pick a screen saver, etc.

In addition to System Preferences, there are also 

preferences for every application on your Mac. For 

example, you can set your home page in Safari to 

allow or block cookies; in Contacts, you can set the 

default template for all new contact cards that you 

create, and decide how to sort your contacts, and 

whether to display last names first. You can find 

these preferences by clicking on the name of the ap-

plication in the Menu Bar as shown in Figure 2.

Perhaps the most overlooked set of application pref-

erences are the ones that control the Finder window, 

but they are also among the most useful. As with 

other applications, you reach them by clicking the 

application name (Finder) in the Menu Bar and then 

Figure 1: Systems Preferences window. Figure 2: Application Preferences window. Figure 3: Finder Preferences window.
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selecting Preferences. When you do, you’ll see a 

panel with four tabs along the top. On the General 

tab shown in Figure 3, you can choose which type of 

devices to display on your Desktop and — more im-

portantly — what folder you want to see when you 

open a new Finder window. By default, new Finder 

windows open to All My Files as shown in Figure 4. 

Perhaps, though, you would find it more helpful to 

have Finder windows open to your home folder or 

your Documents folder. All you have to do is click on 

the dropdown menu and select any folder you like. 

If you don’t see the folder you’re looking for, just 

click on Other… and you’ll be able to browse to any 

folder on your computer; when you find it, just click 

Choose.

Another useful Finder preference setting is on the 

Sidebar tab of Finder’s preferences. By default, cer-

tain items are shown in the Favorites section of the 

sidebar, but they don’t include the user’s home 

folder; note that there is no checkmark next to it in 

the screen shot in Figure 5. But if you want the side-

bar to include a shortcut to your home folder — the 

folder where your entire user content is stored — 

you only need to check the box next to it. In fact, 

you can check or uncheck all of the items listed 

under Favorites, but that’s not the only way to de-

termine what appears there. You can also drag and 

drop any folder into the sidebar from the main panel 

of any Finder window. Furthermore, you can rear-

range them in the Favorites section just by dragging 

them up or down.

But wait, there’s still more! In addition to custom-

izing the Finder Preferences, you can also customize 

the toolbar in the Finder window to add or remove 

tools as you see fit. All you have to do is right-click 

in an empty spot in the Finder toolbar as shown in 

Figure 6 and select Customize Toolbar. You can also 

find that selection on the Finder View menu. When 

you do, you’ll see a display something like Figure 7.

Figure 4: Default settings for Finder Window Figure 5: Finder Sidebar Tab window.

Figure 6:To customize Finder window toolbar.
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You can now drag and drop any of the tool icons 

you see into the Finder window’s toolbar. I like to 

install the New Folder and Delete icons in the tool-

bar, but there’s one other useful item in this dialog 

box. Look in the lower left corner and you’ll see a 

dropdown menu that currently says Icon Only. The 

other choices on the menu are Icon and Text and 

Text Only; I prefer Icon and Text; that will put text 

labels beneath each of the tool icons in the toolbar. 

After you’ve finished customizing the toolbar, click 

the blue Done button in the lower right corner of 

the dialog box. If you ever decide you want to revert 

to the original set of icons in the toolbar, open this 

dialog box again, drag the default setup into the 

toolbar and then let go.

At this point, it may seem as though you’ve explored 

all of your options, but guess what? There are still 

some choices on the Finder View menu that turn 

out to be especially helpful. My personal favorite is 

Show Path Bar (Figure 8). Choose this selection and 

every time you open a Finder window, you’ll see the 

full path from your Macintosh HD down to your cur-

rent file or folder displayed horizontally across the 

bottom edge of the window. That information often 

comes in handy.

There are many more ways to customize the layout 

of the Finder window, but the last one I’ll mention 

here is called Show View Options. As the name sug-

gests, you’ll find it on the View menu in Finder. It’s 

particularly helpful to those of us “of a certain age.” 

Look at the folder icons displayed in Figure 9. I’ve 

selected the home folder in the sidebar of the Finder 

window and the main viewing area is now showing 

the standard set of folders that OS X creates for each 

user account. Personally, I get eyestrain trying to see 

those little icons. Luckily, you can make them much 

easier to see by clicking on the View menu and then 

selecting Show View Options near the bottom of 

the View menu. When you do, you’ll get a popout 

dialog box something like the one in Figure 10. Bear 

in mind, though, that the contents of this dialog box 

change depending on whether your Finder window 

is currently set to the Icon view, the List view, the 

Column view or the Cover Flow view in the toolbar 

at the top of the window. In the example shown 

here, I’ve selected the List view.

As you can see, there are lots of check boxes that 

allow you to decide which columns you would like 

Figure 7: Select “Customize Toolbar” from the View menu.

Figure 8: Select “Show Path Bar.” Figure 9: Home Folder in the Finder window.
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to see displayed whenever you open a Finder win-

dow. Their names are all fairly self-explanatory. You 

can experiment with them and decide for yourself 

which ones you consider most useful. The only one I 

would single out is Calculate All Sizes. By default, the 

Finder window only displays the size (in Kilobytes, 

Megabytes, Gigabytes, etc.) of files — not folders. 

So if you want to know how much space one of your 

folders or subfolders is taking up on your hard drive, 

you won’t see it; instead you’ll just see a couple of 

hyphens in the Size column of the display. However, 

if you check the Calculate all sizes box, Finder will 

display the size of all folders. I can’t think of any rea-

son not to check that box.

Finally, I would draw your attention to the Icon size 

and Text size options near the top of the dialog 

box. There are only two icon sizes, but for me the 

larger size is a Godsend; it’s just so much easier to 

see. I also like to bump up the text size from the de-

fault value of 12-point to the much more readable 

14-point.

Putting it all together, after using all of the methods 

described in this article, a hypothetical user named 

Joe Apple Pi has a very different Finder window lay-

out than the original factory version that came with 

his new Mac. Shown below are Joe’s “before” (Figure 

11) and “after” (Figure 12) layouts. On the left we 

see a Finder window as it looks with the factory de-

fault settings. On the right, we see Joe’s customized 

window with larger, more readable icons and fonts, 

Joe’s home folder displayed in the sidebar, the full 

path displayed in the Path Bar along the bottom of 

the window, the New Folder and Delete icons in the 

toolbar, which also has text labels beneath all of the 

icons, and the sizes of all of the folders listed in the 

main viewer pane. I find the customized version to 

be both more readable and also much more useful 

than the way it came from the factory.

All that and we never even talked about customizing 

the Tags shown in the Finder window sidebar…

Figure 7: Select “Customize Toolbar” from the 
View menu.

Figure 11: Default Finder window layout.
Figure 12: Customized Finder window layout.
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Fergy’s Ordeal With His External Hard Drive 
Containing Very Important Stuff
Neil Ferguson

Long ago, Fergy bought an external hard 

drive to use for Time Machine backups. He 

had never done a restore from his Time 

Machine and didn’t know how to do this if it became 

necessary some day.

As time went on, he pretty much filled up his Mac’s 

internal hard drive and, rather than weed out un-

necessary stuff, bought a new external hard drive 

and began shifting data from his internal hard drive 

to his external hard drive. Over a period of time this 

new external hard drive began accumulating im-

portant stuff like pictures, movies, music and many 

other things. Fergy did not want to lose anything on 

this new external hard drive, so he used Time Ma-

chine’s option of also backing up his new external 

hard drive along with his internal hard drive. 

For many years Fergy did not have any problems. 

But one day his new external hard drive that had 

lots and lots of his important stuff on it died, never 

to be resurrected. Needless to say, he was very dis-

traught. Once again, Fergy bought a brand new 

external hard drive. Since Time Machine was back-

ing up two hard drives, the Mac’s internal hard drive 

and the external hard drive, he did not know how 

to retrieve the data of the external hard drive from 

Time Machine.

Fergy knew how to do a Time Machine Restore that 

would restore the backed-up Mac’s internal hard 

drive into his Mac’s internal hard drive but that was 

not his problem. Fergy’s problem was how to restore 

the external hard drive’s data that was backed up in 

Time Machine to his brand new external hard drive 

that was replacing the dead external hard drive.

Well, Fergy did what we all do: he turned to Google, 

‘as Google knows everything.’ Google showed 

Fergy many websites of articles on how to solve his 

problem. With all the various solutions that Google 

presented, he was completely confused—which 

Figure 1.
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is pretty much Fergy’s state of mind anyway. One 

thing that was presented by the many websites 

was that the brand new hard drive should have the 

same name as the dead external hard drive had in 

Time Machine. That was the only thing that Fergy 

remembered out of all this searching. He was still in 

a dilemma as to what to do to get the data out of 

Time Machine.

Fergy had his computer set up so that all his hard 

drive icons were always present on his desktop. 

So, Fergy doubled clicked on his Time Machine icon 

that was displayed on his desktop (right under his 

Macintosh HD icon) as shown in Figure 1. He double 

clicked on this Time Machine icon and it opened up 

revealing the contents of his Time Machine. What 

Fergy saw was a Finder window showing a folder 

with the name “Backups.backupdb” (Figure 2). He 

then clicked on that Backups.backupdb folder icon, 

revealing a folder with the name of his computer, as 

shown in (Figure 3).

Fergy clicked on the folder with the name of his 

hard drive and upon opening it he saw a list of all 

the times that Time Machine performed a backup. 

(Figure 4) shows the most recent backups. He picked 

the last time that a backup was performed where his 

external Seagate hard drive was still functioning.  

A window opened up showing a list of all hard 

drives that Time Machine backs up including his de-

funct external Seagate drive as shown in (Figure 5). 

Fergy double clicked on the name of his external 

Seagate hard drive and was happy to see that all his 

files and folders were actually in his Time Machine 

backup (Figure 6). 

Now, the question was how to get the data out of 

Time Machine and into his new external hard drive. 

He did a lot of searching but couldn’t find any 

references about how to do a restore of the contents 

of his backed up external hard drive to the new 

external hard drive. Fergy decided to take a trip to 

the Apple Store and ask them.

Figure 2.

Figure 3.

Figure 4.
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Ah-Ha! The Apple Store had a solution. The solution 

is to open Time Machine by clicking on the Time Ma-

chine icon on the desktop; navigate down to where 

the content of the dead external hard drive is dis-

played; perform a Select All (CMD+A), which high-

lights all of the folders and files. And then of course 

drag the selection onto the icon of the new external 

hard drive that is displayed on the desktop, and re-

lease the mouse button. 

Voila, it worked! He was ecstatic, so much so that he 

just had to write this story. Fergy doesn’t know if the 

naming of the new external hard drive the same as 

the dead external hard drive was necessary or not, 

but it did work.

A sequel that utilized  
the experience above
One day Fergy was formatting thumb drives to the 

EXFAT format so the thumb drives would hold files 

larger than 4 GB in size. Somehow, unbeknownst to 

Fergy, he inadvertently replaced the name of his ex-

ternal hard drive with the name of one of the thumb 

drives. Yes, when he thought he was formatting his 

thumb drive he was actually formatting his exter-

nal hard drive. When Fergy discovered his dastardly 

deed he sat down and cried. But…he remembered 

how he recently recovered all the data from Time 

Machine that came from his external hard drive, so 

he applied his recently acquired knowledge to put 

his external hard drive data back on his external 

hard drive.

And Fergy lived happily ever after… 

Figure 5. Figure 6.
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Wow!! My iDevice does that?
Ron Masi

Wow!! My iDevice does that? Have you 

wondered why your iPhone, iPad, 

or iPod won’t do X, Y and Z? Well, in 

many cases it will do X, Y and Z, but we just don’t 

know how to tell it to. Below, we’ll start sharing “hid-

den” features and finding out what we are missing. 

After reading this article and following the steps, 

you’ll be able immediately to find all your draft 

email, and make the device read the screen to you 

and stop speaking/playing music after you go to 

sleep. You can do all this with nothing to buy or 

download, since your updated device already has 

these capabilities.

• Can I make my device read 
the screen to me? 
Yes, you can and fairly easily. Go to the Settings 

Menu, choose General, then > Accessibility > 

Speech. From there, all you have to do is turn on 

“Speak Selection.” Now, anytime you choose a text 

selection, your phone will read it to you. If you select 

“Speak Screen” the screen contents are read to you 

when you swipe down from the very top of the 

screen with two fingers. Yes, if you have an iBook on 

the screen, it will read it to you. You can even choose 

the language from this settings screen. This action is 

useful if the page is in several languages; it will read 

them in the language written. To control the speed 

while content is being read, a box appears on screen 

showing an icon of a rabbit and a turtle, allowing 

you to speed up, slow down or stop. If the page 

cannot be read, you’ll receive a written and spoken 

notice something like, “No speakable content could 

be found on the screen.” Give it a try.

• Want to find all your draft 
emails quickly (emails that have 
been started but not finished or 
sent) with just one touch? 
Easily done by opening Mail and holding down the 

Compose icon for a second (it looks like a box/piece of 

paper with a pen on it). Immediately a drop-down box 

with all your drafts is displayed; just tap the one you 

want. In addition, when you quickly tap the Compose 

icon you’re presented with a blank new message page 

ready for you to address and type your email.

• If you like falling asleep listening to 
your iDevice playing/reading etc. but 
don’t want it playing all night, here is 
how to set the timer:
On the bottom pull-up screen, select the Clock icon, 

and then in the lower right corner select the Timer. 

Now set the amount of time you want the device to 

play. Note: just this next step differs slightly by de-

vice.

On the iPad tap the music icon between the Pause 

and Start buttons.

On the iPhone tap When Timer Ends in the middle 

of the screen.

This action opens the When Timer Ends window. 

Scroll down and select the last option, Stop Playing. 

Then tap “Set” in the top right of the window. Now 

when the time you set is up (and hopefully you are 

fast asleep), your device stops playing and goes to 

sleep with you.
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Hot Links
• Wait! Is my Mac looking at me? Worried about your webcam being hijacked?  

http://mac360.com/2016/10/is-your-macs-camera-spying-on-you/

• My 500 GB Time Machine drive doesn’t cut it anymore. Transfer your backups to a new larger drive and press on. 

http://www.macworld.com/article/3125097/macs/how-to-transfer-a-time-machine-backup-to-another-backup-drive.html?idg_eid=5d139d8d7ead280e99465

07f471d520a&token=%23tk.MCW_nlt_mw_macweek_html_2016-10-05&utm_source=Sailthru&utm_medium=email&utm_campaign=MacWe

• Forget your reading glasses? Use the iPhone, Luke.  

https://www.macobserver.com/tips/how-to/iphone-magnifying-lens/

• Startup key combinations are quite useful.  

http://tidbits.com/article/16712

• Produce your own Karaoke scene with your iTunes app. 

http://www.idownloadblog.com/2016/09/23/view-song-lyrics-in-apple-music-on-mac/

• Hey Siri! Here’s a useful menu of Siri queries: 

https://hey-siri.io
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The Power of Preview: 
Converting Images and Exporting PDFs
Josh Centers and Adam C. Engst 

In our exploration of Preview, OS X’s built-in image and PDF powerhouse, we’ve 

walked you through getting files into Preview (see “The Power of Preview: Pulling Files 

into Preview [1],” 25 February 2016) all the way to advanced editing techniques 

(see “The Power of Preview: Advanced Editing Techniques [2],” 25 April 2016). As our series 

draws to a close, it’s time to end it in the natural place: saving and exporting your 

files.

Since Preview uses the Modern Document Model (see “The Very Model of a Modern 

Mountain Lion Document [3],” 7 August 2012), it saves existing files automatically as 

you edit. Likewise, Preview supports Resume, so if you quit Preview without sav-

ing, or Preview closes due to a crash or power outage, you won’t lose your work.

But that’s all Mac 101. More interesting is how Preview can convert your files into 

different formats. You can even export a PDF as an image or vice versa! That can 

be handy if, for instance, you have a one-page PDF flyer that you want to convert 

to a PNG or JPEG so it can be posted more easily on Facebook.

Three commands in Preview’s File menu help you export your files:

•	 Export: This command enables you to save a copy of your file with a different 

name, in a different location, and even in a different format.

•	 Export as PDF: As you’d expect, this command is mostly a faster way to get a 

PDF out of Preview. Oddly, the Export as PDF dialog lacks the Quartz filter and 

encryption options that the regular Export command does, and all the other 

options available with the next command.

•	 Print: You may not realize this, but in OS X, you can “print” anything to a PDF! 

More on this in a bit, but for now, just know that using the Print dialog to ex-

port a PDF offers some advantages.

There’s also a fourth option, Save As, which doesn’t appear by default. Hold 

down the Option key to change the Duplicate command to Save As. But with 

one minor exception that we’ll cover later, Save As does the same thing as 

Export, so there’s no need to bother, unless you’re just working out of habit. If 

you prefer Save As to Duplicate, check out “Put Save As Back on the File Menu [4]” 

(30 November 2015).

Converting Image Formats — We assume that you understand the basics of 

naming, saving, and tagging files, so we’ll focus on the interesting bit: format 

selection. The Export dialog’s Format pop-up menu shows only 6 file formats by 

default, but if you Option-click it, Preview displays 19 choices!

This conversion capability is handy, because if you have a JPEG and need a PNG, 

all you have to do is open the JPEG in Preview, choose File > Export, change the 

Format pop-up menu to PNG (note the resulting file size estimate), and click 
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Save. But if you don’t already know that you need a PNG, which format should 

you pick? It depends on your intended destination for the file. We’ll look at PDF 

next, but the four most common image formats are:

GIF [5]: An ancient format, first introduced by CompuServe in 1987, the GIF im-

age format has been superseded by PNG in every way but one: GIF supports a 

flipbook-style animation, which is a topic for another article. Don’t use GIF unless 

you want to create an animation, or just feel like reliving the battle over how it’s pro-

nounced [6].

JPEG [7]: JPEG is great for photographs, and any image-viewing app can open JPEG 

images. When exporting as JPEG, you can reduce the quality to reduce the file 

size, which is useful for Web publishing. However, be aware that JPEG’s compres-

sion is lossy, which means data is actually thrown away during saves and can’t be 

recovered. Because of this, every time you edit and save a JPEG, the picture qual-

ity will degrade a little. Don’t confuse JPEG with the JPEG-2000 [8] format. Despite 

having a similar name and coming from the same group, they’re entirely different. 

In theory, JPEG-2000 is better, but in reality, it doesn’t offer many benefits.

PNG [9]: Conceived as an improved, non-patented replacement for GIF, PNG is 

designed for Internet image sharing, as opposed to professional-quality printing 

(it doesn’t support non-RGB color spaces like CMYK). PNG uses lossless compres-

sion, making it ideal for images that you need to edit repeatedly, and it excels 

with computer-generated images that have large, uniformly colored areas, like 

screenshots and logos. There are two variants of PNG that support animation — 

MNG and APNG — but support and usage are minimal at best, so GIF remains 

the choice for animations. Because of its lossless compression, photos saved in 

PNG format have much larger files than those saved in JPEG format. By default, 

OS X creates screenshots in PNG format, though that can be changed with a 

defaults write command if necessary. (iOS screenshots are also saved in PNG for-

mat.) Be careful using JPEG for screenshots, or you may see artifacting in areas of 

solid color. In the example below (click it to zoom on our Web site!), the top im-

age in PNG format is 1.4 MB, thanks to the photo background (Figure 1), whereas 

Figure 1.
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the bottom picture, saved at 50 percent quality in JPEG format, is only 152 KB. 

Notice that the photographic portion is nearly indistinguishable between the 

two, whereas the solid blue in the book cover shows artifacting, particularly near 

the white text, in the JPEG image) When exporting a PNG from which you’ve re-

moved the background with the Instant Alpha tool, as explained in “The Power of 

Preview: Advanced Editing Techniques [11]” (25 April 2016), pay attention to the Export 

dialog’s Alpha checkbox. This setting enables or disables transparency, which 

sets a particular color as transparent, so the background color (of the Web page, 

say) shows through. If alpha is disabled, transparent portions of your image will 

be rendered as white. It’s worth remembering that while PNG and GIF support 

transparency, JPEG does not. So if you convert an image in one of those two for-

mats to JPEG, whatever color has been declared as transparent (usually white) 

may instead be rendered as another color. The code in the TidBITS Publishing 

System that makes thumbnails of graphics always creates JPEGs, which means 

that thumbnails of certain PNGs that contain transparency end up with black re-

placing the transparent portion of the image (at least until we notice and fix it).

TIFF [12]: TIFF is another venerable format that has evolved over the years to be 

extremely capable and useful, though today it’s mostly used in the print world. 

TIFF files can be compressed, though that’s not required, and when saving one in 

Preview, you can choose from no compression, LZW compression, and Packbits 

compression. The two compression choices are lossless, like PNG’s compression, 

and LZW seems to result in a smaller file. Also like PNG, TIFF supports transpar-

ency, but what sets it apart is its support for layers. In graphics programs like 

Photoshop and Pixelmator, layers enable you to work on the image as though 

you’re drawing on a transparent sheet of acetate. Objects on layers can be ma-

nipulated independently, and layers can be turned on or off to try various edits 

without committing to them. Unfortunately, Preview doesn’t support layers at 

all, so while it can open a TIFF that contains layers, it “flattens” them into a single 

layer. The same goes for edits made in Preview; you can add a shape to a TIFF 

and move it around while editing, but as soon as you close the image, the shape 

is merged with the image layer.

So, if you’re unsure, which format should you use? If the image is photographic, 

JPEG provides the best combination of quality and reduced file size. On the other 

hand, if it’s a computer-generated graphic with large areas of uniform color, like 

most screenshots, or if transparency is needed, stick with PNG. TIFF is useful pri-

marily in the print publishing world; for instance, a publisher may require that 

screenshots for a book be in TIFF rather than PNG for color workflow reasons. 

Also, use TIFF if you will need to edit with layers in an app like Photoshop.

What about all those other image formats? For the most part, they’re old, un-

common, or both, at least in the Mac world. The two exceptions are Photoshop 

and QuickTime Movie, which are plenty common, but unlikely to be useful within 

Preview. Saving a file in Photoshop format does mean that Photoshop can open 

it natively, but as far as we can see, there’s no advantage over PNG in that regard. 

And we can’t figure out what file format you can open in Preview that you could 

later save using QuickTime Movie; animated GIFs seemed the most likely, but 

they can’t be saved as QuickTime movies. If you’d like to read up on these other 

formats, here’s a full list, with informative links:

•	 ASTC [13]
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•	 ICNS [14]

•	 JPEG-2000 [15]

•	 KTX [16]

•	 Microsoft BMP [17]

•	 Microsoft Icon [18]

•	 OpenEXR [19]

•	 PBM/PGM/PPM [20]

•	 PVRTC [21]

•	 Photoshop [22]

•	 PostScript [23]

•	 QuickTime Movie [24]

•	 SGI [25]

•	 TGA [26]

Despite the length of that list, there are many more graphic formats out there. If 

you run across a file that you can’t open, or if you need to save an image in a for-

mat that Preview doesn’t support, turn to Lemke Software’s venerable  

GraphicConverter [27], which can import approximately 200 file formats and export 

in roughly 80 formats.

Exporting to PDF: Quartz Filters — Entire books have been written about Porta-

ble Document Format (like “PDF Hacks [28],” “PDF Explained [29],” and “Developing with 

PDF [30],” all from O’Reilly Media). Originally created by Adobe but an open ISO 

standard since 2008, PDF is one of the tech world’s most useful file formats. In 

the simplest terms, PDF represents the text and graphics of a printed document 

in digital form. The most common usage of PDF is in printing and publication, 

with examples ranging from government forms to Take Control ebooks. But PDF 

is incredibly flexible — OS X’s Quartz rendering engine uses PDF internally, which 

is why it’s so easy to export things as PDF in OS X.

Preview’s Export dialog provides two extra options when exporting PDFs: Quartz 

filters and encryption. Quartz filters modify the exported PDF in various ways, ei-

ther adjusting the look of the document or tweaking its format under the hood. 

In the first category, you’ll find Quartz filters for Black & White, Blue Tone, Gray 

Tone, Lightness Decrease, Lightness Increase, and Sepia Tone. The tonal adjust-

ments do what you’d expect, making the image black-and-white or turning all 

colors into shades of blue, gray, or sepia (Figure 2). The two lightness filters apply 

to all colors as well, so their effects are relatively subtle in photos, but can make a 

large difference to colored text. (See Figure 3).

Figure 2.
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When it comes to fiddling with the document format, Apple provides Quartz 

filters for Create Generic PDFX-3 Document and Reduce File Size. PDFX-3 is a 

subset of PDF with printing-related requirements that facilitate a color-managed 

workflow. Honestly, if you need a color-managed workflow, you should be (or 

already are) using Adobe Acrobat Pro. Reduce File Size is alluring, but beware if 

you have images other than photos in your document. When you use Reduce 

File Size, Preview uses lossy compression to reduce the quality of every image in 

the document, making non-photos notably fuzzy (Figure 4). Photos see a qual-

ity reduction too, but the effects are less noticeable. Happily, Reduce File Size 

has improved radically from earlier versions of Preview, which also deleted useful 

metadata like a PDF’s table of contents.

Exporting to PDF: Encryption — Preview’s Encrypt checkbox may be more use-

ful to you. If you’re sharing a PDF that contains confidential information, you can 

Figure 3.

Figure 4.
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reduce the chances that it will be read more widely by encrypting the document, 

after which a password is necessary to display it.

In PDF parlance, the password created by Preview’s Encrypt checkbox is a “docu-

ment open” or “user” password, as opposed to a “permissions” or “owner” pass-

word, which restricts editing and printing of the document. More on how to set a 

permissions password in a moment; you can’t do it from the Export dialog.

Preview offers no facility for entering the permissions password to override pre-

viously set restrictions, with one exception. If you open a PDF encrypted with a 

permissions password that prevents changes, and then try to use Preview’s File 

> Export or Export as PDF commands, you’ll be prompted for the permissions 

password. That is, unfortunately, false security because any change in a permis-

sions-protected PDF causes Preview to make a copy that you can save. Plus, while 

Export may ask for a password, File > Save As does not. Oops.

To encrypt a PDF with a document open password, choose File > Export, select the 

Encrypt checkbox, enter a password, and then enter the password again to con-

firm it. From then on, when anyone — including you — tries to open the encrypt-

ed PDF, in any PDF-savvy app, they’ll be prompted for the password (Figure 5).

As far as we’re aware, as long as the document open password is relatively 

strong, there’s no way to brute force it. (If you use a weak password, a diction-

ary attack may be able to crack it.) You may run across utilities or Internet ser-

vices like PDFUnlock [35] that claim to be able to remove passwords from PDFs. 

They’re talking about the permissions password, not the document open pass-

word, and thus can’t do anything for you that you can’t accomplish more effi-

ciently in Preview itself.

What if you want to remove a document open password from an encrypted 

PDF? As long as you know the password, it’s simple — just open the PDF, enter 

the password, and then use Export to save it again, without selecting the Encrypt 

checkbox. This technique might be useful if a document was confidential for a 

time, but no longer needs to be.

Printing to PDF: More Encryption — As previously mentioned, you can “print” 

any document from any app to a PDF. This is a system-wide feature in OS X, 

thanks to Quartz’s foundations in PDF, and is tremendously useful for testing 

what a print job will look like before sending it to your printer or for saving a Web 

page as a PDF.

Figure 5.
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But why print to a PDF from Preview, which has built-in PDF export capabilities? 

For one thing, it offers more metadata and security options than Preview’s ex-

port feature, but it also solves a common Preview problem.

Since we began this series, several readers have written in with the same issue: 

you mark up a document in Preview, save it, send it to a collaborator, and they 

don’t see your annotations. We don’t know why this might happen — PDF is a 

standard, but that doesn’t mean every app implements it correctly — but print-

ing to PDF appears to cause the annotations to show up properly in most cases.

To export a PDF in this way, choose File > Print. In the resulting dialog, click the 

PDF pop-up menu in the lower left and choose Save as PDF. (Further down in 

that menu, you may see a bunch of printing workflows that various apps install 

for you. They make it easy, for instance, to print a document to PDF and send it 

with Messages in one step.) See Figure 6.

In the Save dialog that appears next, you’ll notice a few additional options. You 

can enter not just the filename, but also title, author, subject, and keyword meta-

data. This standard PDF metadata becomes visible in Preview’s Inspector window 

(choose Tools > Show Inspector or press Command-I), in other PDF apps, and 

even in the Finder’s Get Info dialog (Figure 7). But there’s more! Click Security 

Options, and you can set both the document open and the permissions pass-

words for the PDF, and choose whether the permissions password will restrict 

changes, printing, or both. 

Figure 6. Figure 7.
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Preview in the Rearview Mirror — This article wraps up our series on Preview. We 

hope you’ve enjoyed it, and if you have more questions about Preview or tips to 

share, let us know. Who knows what additional features might lurk within Pre-

view’s depths?

Finally, although we don’t have a schedule set yet, the response to this series has 

been so positive that we’re planning to start on a “Take Control of Preview” book.
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Responses to General Meeting Questions, May 31, 2014
Editor’s Note: Two years ago, we asked Pi members 

to respond to a series of questions regarding their 

introduction to Apple devices, and their subsequent 

experiences with them. Here are some responses we 

received. They are presented here as submitted by the 

responders.

Helen Barsalou
Were you one of the first Apple users, an early Mac 

enthusiast, or a later switcher from the PC side? Why 

did you buy your first Apple product?

In 1985 or ‘86 I was still working full time as the art 

director for JWK International, one of the “Beltway 

Bandits.” One of the vice presidents bought a Mac. 

None of the other offices had one. No computers at 

all! Just typewriters.

She had a contract to develop a program of ques-

tions that patients could answer in a doctor’s office. 

It involved things like, “Which of these foods have 

you eaten this week?” She asked me to draw pic-

tures of many foods, so there could be eight pictures 

on one page of a similar food, like eight different 

fruits, eight different meats, etc. Then a nutritionist 

would later add the food values to the pictures. The 

doctor could then see what was missing or needed 

in their diet.

This computer was so small. (Maybe a ten-inch 

screen?) Everything was bit-mapped. I did many 

pages of foods. It was like magic to be able to draw 

with a mouse. I really enjoyed it. When I retired from 

the company in 1987 and started painting, mostly 

watercolors, I decided to have a show and sell my 

work. I needed a mailing list for invitations. My hus-

band knew a little about computers from his work, 

so we bought our first Mac.

What made you stick with Apple products through 

the days when doom was predicted, or convinced 

you that the company would survive and flourish 

and deserve your cash? How many devices have you 

owned?

As far as I knew, it was the only computer that had a 

graphics capability.

How has your use of Apple products evolved over the 

years? What are you doing now that you didn’t do 

originally and vice versa? 

I still have an old Power Mac, not even with the Intel 

processor. When we bought this one, I was told the 

Intel processor was not yet good with graphics (It 

had just come out.) So we decided to stay with the 

Power Mac. I do very little graphics on it. I have a 

scanner, so I prefer to draw or paint “in real life.” I use 

it mostly for contacts with the several art groups I 

belong to. I also taught watercolor for 18 years, so it 

was a good tool for that.

What device have you purchased most recently? 

My husband has an iPad and loves it. 

Which one is most essential to your life? How can 

the Pi help you to get the most out of your Apple 

technologies? 

I’m not sure. Some day we will probably buy a new 

one.

Finally, what new Apple device would you be most 

likely to buy, should they develop it? 

Don’t know.
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Jimmy Nalley
My first computer was a Macintosh 128K that had 

been upgraded to 512K. I purchased it in July of 

1985 from Raoul at MacCorner in Gaithersburg, MD. 

I came to find out that he had purchased a large 

number of the 128K’s from the government and pro-

ceeded to upgrade them and sell them as new for 

$2,000.00 with a full warranty. I don’t know if mine 

was used or not, but I was completely excited by 

my first computer. I had been wanting one for quite 

a long time. I just wasn’t ready to learn line com-

mands. 

I WAS “The Rest of Us.” I wasn’t a programmer or 

computer engineer. I was a musician, and I simply 

wanted a machine that would store the sounds and 

sequences and samples made on my new Kurzweil 

K250 digital keyboard. The owners’ manual dictated 

that the only computer capable of storing the in-

formation generated by my Kurzweil was the new 

Macintosh. So...on top of my $11,000 keyboard I had 

to purchase a $2,000 computer, $1,500 Bernoulli Box 

(5-MegaByte cartridges), a $300 300 Baud modem, 

and assorted software. Thus began almost thirty 

years with a heading in my budget labeled “Apple.” 

That fact that I could create documents in Mac-

Write or MS Word 1.0, make databases in MS File 

1.0, communicate on Compuserve, or do a spread-

sheet in MS Excel 1.0 was an incredible bonus that 

opened a whole new and time-consuming world 

for me. My dad and I were amazed by moving the 

mouse in MacPaint and drawing on the screen. We 

had seen this in a futuristic exhibit at the IBM pa-

vilion of the Seattle World’s Fair in the early 1960’s. 

It only took another twenty-plus years to become 

a mainstream reality. 

Back then the Apple Pi helped take me from new-

bie to an educated and fairly proficient Mac user. 

I was thankful for the Tuesday night beginner 

tutorials. I’m sure they went a long way to evange-

lize for and establish a strong base of Macintosh 

users. I became a Mac “Fan-Boy.” I never veered 

from my Macs even during the worst of times for 

Apple, though technically I did veer a little when I 

purchased a Mac clone from Power Computing in 

1997. I’ve owned eight different desktop Macs, one 

laptop, one iPod, two iPhones, one iPad, and an 

assortment of scanners, printers and other periph-

erals. Apple’s attention to quality and detail have 

made my choice of computer a «no-brainer» for 

almost thirty years. They just work. If I see a use 

for a new product class from Apple, I will be a re-

vision 2.0 adopter.

I have consistently used Macs in my recording 

studio then and now. However my other uses of 

Apple products have changed greatly over the 

years. I ran my resort property management com-

pany from 1985 to 1995 with a Mac Plus. Reserva-

tions and maintenance schedules for short-term 

vacation rentals were done in Excel, inventories in 

MS File, brochures designed with Photoshop and 

Quark and/or Pagemaker. I’m still using the mail 

merge capability of Clarisworks 5.0 on an old Snow 

Globe Mac running MacOS 9.2 to generate letters, 

contracts and a customer database for my cur-

rent DJ/Karaoke Allstar business (1993 to present). 

I actually DJ from a combination of iTunes on my 

eleven-inch MacBook Air and my iPhone 5s us-

ing Beats. Needless to say the iPhone and the App 

Store and iOS have opened limitless possibilities 

in mobile computing and communications that I 

never dreamed of when I purchased my first Apple 

Macintosh computer way back in 1985.

mailto:feedback%40wap.org?subject=
mailto:feedback@wap.org


Washington Apple Pi Journal
Volume 38, No. 1

32

Herbert Rust
My first venture into computing was pre Apple his-

tory and was a large laptop, which I used for my of-

fice accounting and continued to use solely for that 

purpose. I did not use it for anything else because 

the Microsoft operating system was a nightmare of 

inoperability. So then came the first Mac; I got that, 

and really that was my first actual “computing.” Like 

many of us, I have never left Mac, never doubted 

their ability or future. As some of you might know, 

many years ago, long before the iPad, Steve did a 

film of his “device of the future.” It was basically a 

Pad, with capabilities far beyond what even the new 

iPads offer, so I kind of already knew where we are 

heading.

I currently have a MacBook Air, an iPad Air and a new 

iPhone 5S. Love them all and eagerly look forward to 

the future of Apple for us all. By the way, it’s not just 

for youngsters. I just had my eighty-second birthday 

and am looking forward to setting up a new health-

care website and blog.

Art Milholland
Re the questions you pose, let me say briefly: 

1. I had an Apple II years ago to try out, but PC’s 

became a University of Maryland standard.  

2. I got an early Intel Mac Mini to try it out. I was 

hooked by a label program called Imprint (which 

is out of business but I still use it at least weekly) 

and then by DEVONthink. There are no Windows 

equivalents for either one, but no Mac program to 

replace Imprint, either. DEVONthink is essential for 

my work, and Imprint is very handy. 

3. I run CrossOver so I can use three or four Win-

dows programs without buying Windows. I did try 

Parallels a long time ago, but it was never smooth. 

4. I have a 2012 Mac Mini 2.6GHz w/ 16 GB 

memory, and an Amazon Basics DVD drive. 

5. Mavericks is somewhat sluggish compared with 

Windows 8 on my HP laptop. Each new Mac OS 

seems more bulky than the one before. It got very 

slow with Mavericks, but was greatly improved af-

ter a complete re-installation via the App Store (an 

easy but lengthy process). Many Apple Pi members 

could benefit from this procedure, and I posted 

this advice in two places, but I don’t know if the 

word ever got out. 

6. I have an iPod Touch and, most recently, an 

iPad Air, which I use very little so far. 

7. I don’t think I have need of any particular future 

product.

8. I fear the App store may be more and more 

problematic, with “sandbox” restrictions. 

9. Cloud confidentiality and security are a growing 

concern. 

10. I don’t use social media, including Facebook, 

Twitter, Linked In. Perhaps if I were exposed to Ap-

ple Pi tutorials on these, I might engage. 

11. Beltway traffic makes attendance at Apple Pi 

meetings in Virginia a real challenge. The trip is 

long and often feels dangerous so I don’t come as 

often as I used to when they were in Maryland.

Ed Kelty

Our family started with the Apple II to introduce our 

kids to computing while they were young. We had 

them learn how to keyboard before we “discovered” 

that there were some games in the package. I, per-

sonally, never liked the somewhat awkward Apple II.

The conversion occurred when I joined a bunch of Pi 

enthusiasts at the East Coast introduction of the Mac 

at what was then called the Departmental Audito-

rium on Constitution Avenue. The Apple technicians 

sold me immediately with their presentation of a 

visually oriented operating system. We joined in the 
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group purchase from a company in Pennsylvania. I 

have had several versions of the Mac since. 

I thought the company would continue to serve a 

niche market because of its competence and qual-

ity, even while losing market share. We have had 

several versions, but my favorite was the silent Cube. 

The tiny box contained the same computing power 

as the original Cray 1 supercomputer. If it was good 

enough to be on the desk of Steve Jobs, it was good 

enough for me. 

I am not a power user. Mostly I use the Mac for 

e-mail, writing, and searches. The only program I 

miss from the first Mac is MacDraw. It was a won-

derfully simplistic program, which I incorporated in 

my newsletter at the time. The newer programs are 

more sophisticated than I need. The biggest thing I 

miss are the manuals. When Apple published them, 

they were the best manuals in the world for any 

products. The texts were great and the illustrations 

were of superb quality. Daily, I use an iMac with a 

big screen. The most recent purchase was an iPad, 

which I mostly use when traveling. The Pi has contin-

ued to inform me about potential computer applica-

tions, even if I don’t use them personally. 

 I am curious to see what Apple will do with the TV 

interface.

John DiBella
What made you stick with Apple products through 

the days when doom was predicted, or convinced 

you that the company would survive and flourish 

and deserve your cash? How many devices have you 

owned?

I already owned three Apple computers (Apple II+, 

Mac Classic, and the MAC Quadra 610), plus I had the 

software and didn’t want to spend any more money 

on another system.

During the hard times in the early to mid-1990s, I 

attended almost every monthly WAP meeting. So I 

guess having a good local support group made me 

feel that the Apple product line would eventually 

improve and maybe overcome its business manage-

ment problems. 

I used many different computer systems, test equip-

ment and various electronic devices in my work. I 

feel that HP, Tektronix, and Fluke made the best lab 

equipment. And I feel the IBM Mainframes and Ap-

ple made the best computers, although Wang was 

great for word processing and Sun Microsystems ap-

peared to be a Mac on steroids. 

Linda
I bought my first Mac in 1984 and carried it to work 

every day. Then I bought a used Lisa (which I donat-

ed to the Pi years later). In Oct. 1987 I made my best 

purchase - 100 shares of Apple stock. 

When Apple announced a laptop, there was tre-

mendous interest where I worked. We asked Apple 

to send someone with one to show us. We had over 

200 attending, but Apple sent the worst speaker 

possible, who told us about it instead of showing, 

and the IBM/MS types dominated for years later.

I am now retired and out of the area.

Kevin W. Parker 
My first Apple—and my first personal computer—

was a “Fat Mac,” with a whopping 512k of memory, 

that I bought in 1985 with a paycheck-secured loan 

from the company I worked for at the time. I went 

with the Mac over the alternatives because I was a 

computer programmer by day and was tired of try-

ing to keep straight all the different command line 
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interfaces I had to deal with. I wanted something 

more intuitive, plus I figured my wife would be less 

intimidated by a Mac.

I upgraded it several times, first to a 512kE (I think 

that’s the term) and then to a Mac Plus. I’ve still got 

it in storage somewhere. Maybe some museum will 

want it someday....

Circa 1994 I upgraded to a PowerMac 6100, which 

stood me in good stead for some years. I don’t recall 

ever worrying about Apple going out of business, so 

that never concerned me. 

A couple of years into the new millennium, with 

Apple on the rebound, I bought one of the first flat-

panel iMacs. That and the upgrade to OS X were 

both interesting experiences, and I believe I wrote 

an article for the WAP Journal about it. 

In 2004, I suffered a blood clot in my leg, and it 

became painful to sit for very long without my leg 

propped up. So in 2006 I bought a MacBook Pro that 

I could prop up in bed with, and my wife inherited 

the iMac. (I think I wrote an article about that, too.) 

That worked well until the laptop died, so I replaced 

it in 2011 with a more current version.

Before then, though, I bought an iPad, uncharacter-

istically being an early adopter (at least by my stan-

dards), buying it in June of 2010. It was a huge hit 

at my high school reunion. For one thing, the band 

at the evening’s festivities was asked to play a song 

they didn’t have the sheet music for. I was able to 

find it online and let them read it off the iPad.

What else? My wife and I have both had iPods for 

ages. Hers is a Classic, mine is a 2006-era Nano. The 

old iMac got too slow, so several years ago I got her 

a new one. And last year I decided that I didn’t like 

traveling with my main laptop with so much of our 

personal information on it, so I got a MacBook Air 

that I think is amazing. I think I actually prefer it por-

tability-wise to the iPad.

Oh, I almost forgot the Mac Mini that’s the heart of 

our relatively bare-bones entertainment system. We 

mostly use it as a glorified DVR, using a software 

package to record programs to view later. 

My next major Apple purchase will definitely be a 

new iPad as there are just too many apps that won’t 

run on my first-generation one. I’m planning on do-

ing that as soon as they come out with the next ver-

sion. (I was hoping the rumors of an upgrade in April 

would come to pass, but alas they didn’t.)

My laptop is definitely the one device I’d want to 

rescue in a fire. I use it for financial management, 

emails, getting online generally, managing photos, 

writing, playing games, and so on. The iPad is more 

of a backup, and the Air is mostly for getting by 

when I’m away from home; I haven’t really kitted it 

out to be fully functional.

Other than the changes that came with the Inter-

net, there haven’t been too many changes to my 

behavior when it comes to computers. Even then I 

can remember getting online to BBS’s decades ago, 

followed by GEnie, followed by AOL, followed by 

the World Wide Web (thanks to WAP’s TCS Explorer 

service) in all its glorious variety. Other than that, I’ve 

always used them for finances, writing, and game-

playing. 

I can’t think of any possible new Apple device I’d like 

to have. I’d just like to have current ones be a little 

bit smarter. For example, it shouldn’t be necessary 
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for me to reload my online comics every day. My 

iPad should be smart enough to realize that I want 

that EVERY DAY and just do it.

Martha Lufkin 

Were you one of the first Apple users, an early Mac 

enthusiast, or a later switcher from the PC side? Why 

did you buy your first Apple product?  

I bought my first computer in 1986, the Mac Plus. 

My husband had used a Mac at his previous job and 

missed having one.

What made you stick with Apple products through 

the days when doom was predicted, or convinced 

you that the company would survive and flourish 

and deserve your cash? How many devices have you 

owned? 

 It was a good product and met my needs; it never 

occurred to me to change. I can recall sixteen devices.

How has your use of Apple products evolved over the 

years? What are you doing now that you didn’t do 

originally—and vice versa? What device have you 

purchased most recently? Which one is most essen-

tial to your life? How can the Pi help you to get the 

most out of your Apple technologies? 

Originally I could turn it on. Then I became a pow-

er user, could trouble-shoot extension conflicts, 

learned to swap out hard drives and ram, reinstall 

the OS, and got a job in tech support. But now I have 

an Air; nothing I can replace in this one! Most recent 

device is the iPhone 5c. I use my Air and iPhone daily 

but I think the laptop is the more essential of the 

two. I love hearing about new software (and apps 

for the phone). Maybe someday the phone will be-

come more essential.

Finally, what new Apple device would you be most 

likely to buy, should they develop it?  

A lighter-weight phone would be ideal. And after 

owning a smart phone for six months, I realize 8GB 

isn’t nearly enough.

Jim Utterback 

We purchased our first Mac in 1984, a IIC. My wife, 

Ann, was writing a book and needed a word proces-

sor to do it efficiently. She was able to teach herself 

how to use the computer without previous knowl-

edge and has used Macs ever since. By the time we 

were done with that particular machine, it had an 

external floppy drive, two printers, and added RAM. 

The toughest thing was the printers, since not many 

models were available at the time. We needed a lot 

of help with those, one a dot matrix, and one a daisy 

wheel.

We graduated from those to a IIx, I think—one of 

the beige boxes—a clamshell iBook, and a blue G3 

iMac. Since then we’ve had a succession of iMacs, 

hers now a 21-inch 2010 model, and mine a 27-inch 

2013 model. Ann still laughs about her “$1000 type-

writer”, since word processing is most of her work, 

but that disguises the fact that she has put together 

four websites and a blog. And we’ve never even con-

sidered PC’s, although we both learned to use them 

in our jobs. In fact, the irritations we encountered 

when working on PC’s were what convinced us to 

stick with Apple no matter what.

My history takes up when I inherited her IIC, which 

I used mostly for bills and simple accounting re-

cords. However, when I moved into a training po-

sition, I needed to get up to speed on photo and 

video processing as well as advanced MS Office 

functions. Since the office I worked out of was all 

PC, I learned that platform as well, but the Macs 

made it easier to teach myself the skills I needed 

and to create agnostic materials that anyone could 
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use. And when I started, there was no other user-

friendly video application but iMovie, so I persuad-

ed my trustees to purchase Macs: a PowerMac G4 

and a G3 iBook. Eventually I moved on to Minis, 

and then to the iMac when I retired. 

Early on, we employed a consultant we found at a 

computer store, who assisted us when we got stuck 

somewhere, and eventually I picked up a lot of his 

skills. That’s how I found the Pi, and have used its 

services at the clinics, through the Journal, and in 

the online forums. So I’m the family geek, and I vol-

unteer as a tutor each week for anyone in our retire-

ment community who needs help with Apple ma-

chines. I’m a huge fan of the Journal and the online 

community. They’re worth the annual subscription 

easily.

We have owned seven Macs, and now two iPads 

and an iPhone. We are both on our second iPad, and 

we’ve also owned two iPod Touches. In my busi-

ness, my home office had a total of five Macs over 

the years, including two laptops. My 27-inch iMac is 

still essential to my life, both for its larger screen as 

my eyesight gets fuzzier, and because I still do a lot 

of photo and video processing. But we both use our 

iPads daily for most of our communication and read-

ing. It’s especially important to Ann, who had one 

from the first day, since she has vision problems and 

a chronic disease that prevents her from sitting at a 

desk for very long. She reads now almost exclusively 

on the iPad using Kindle.

As for the future, I’m not sure what new device we 

would consider. We may well be on our last desk-

tops. We’ll definitely upgrade our iPads as needed, 

but smaller handheld devices are pretty much out 

of the question, because of the screen size. We have 

an Apple TV, which is great, and we would upgrade 

that if a better model comes out, especially if there 

were some kind of DVR included.
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Volunteer Opportunities

Members 
Helping Members
Dedicated volunteers are the lifeblood of the Pi. 

Whether it is installing a hard drive at a Clubhouse 

Saturday event, answering questions at a General 

Meeting, or placing advice on the TCS Forums, there 

are many ways to pitch in and help, depending on 

a member’s interests and talents. Please consider 

making a commitment to ensure that the Pi remains 

a strong and energetic club dedicated to helping 

its members. All volunteer efforts are appreciated. 

Check out these areas where assistance is needed.

Featured Position – General Meeting Webcast Director

The Pi currently captures its General Meetings on videotape for future viewing by members who can-

not attend the meetings. Using the same camera, we are able to concurrently produce live webcasts so 

members can view the meeting in real time via the Internet. We need a dedicated volunteer to oversee 

the technical and production aspects of this webcast.

There are various technical components to putting up the video on the Pi’s Ustream web page.  

The Webcast Director needs to ensure that the equipment is properly set up and functioning, and needs 

to monitor the audio and video streaming production from start to finish (or designate someone to do 

this) to ensure satisfactory audio and video quality. The Webcast Director will not be responsible for any 

other part of the General Meeting program, but will focus exclusively on the webcast production.

Any previous experience in TV or video production would be advantageous, but is not required. A basic 

understanding of video and audio equipment and how to connect them would be helpful, but the con-

tracted cameraman has primary responsibility for equipment hookup. The Webcast Director needs to 

make sure that the meeting presenters do not stray from their predetermined stage positions, so they 

remain adequately illuminated for the entire presentation. Also, this person should be available in case of 

a technical or other problem that would require the speaker to temporarily suspend their presentation. 

Case in point: the Webcast Director will stop the action when the cameraman indicates that a new tape 

needs to be swapped out in the video camera.

If you are interested in helping out with an eye on taking over this important position, contact  

office@wap.org.
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Journal  Managing Editor
The Journal is an established, time-honored publication of the 

Washington Apple Pi and it is in need of someone to take over 

as Managing Editor, leading a team of dedicated and highly 

skilled volunteers. The Journal schedule calls for bi-monthly 

publications, and most of the activity occurs in the three 

weeks leading up to the publication date. In addition, this 

person will be a member of the Pi’s Publications Committee, 

which has oversight of all printed material published by the Pi. 

The job is challenging, but very rewarding.

If you enjoy writing and want to help the Pi progress, this is 

the job for you. If you enjoy working with enthusiastic col-

leagues on meaningful projects, apply today.

Contact the interim Journal editor, Jay Castillo, at: 

editor@wap.org with any questions or to express  

your interest.

General Meeting Manager
Our General Meeting programs need someone dedicated to the planning and managing of these im-

portant club events. The job includes coordinating meeting activities, making any necessary arrange-

ments, and managing the behind-the-scenes tasks. While it sounds like a job for Superman, that really 

is not the case. If you have juggled household duties or been an office administrator, you have the 

skills. While another Pi manager emcees the meeting, you will be making him or her look good!

Because this activity needs to be approved by the Pi’s Management Committee, the volunteer will serve 

as an adjunct member of that committee. This volunteer opportunity is guaranteed to keep you busy, and 

when the meeting is over and everything is packed up, lunch is on the Pi.

Send your inquires to office@wap.org to express interest and we’ll go from there.
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